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AGS Publishing
Software License Agreement
IMPORTANT — READ CAREFULLY: This is a software license agreement
(“License”) between you (“Licensee”) and AGS Publishing (“Licensor”)
governing the AGS Publishing Software (“Software”). By installing,
copying, downloading, accessing or otherwise using the Software, you
agree to be bound by the terms of this License. If you do not agree to the
terms of this License, Licensor is unwilling to license the Software to you.
In such event, you may not use or install the Software, and you should
promptly contact Licensor to obtain a refund.

The Software is protected by copyright laws and international copyright
treaties, as well as other intellectual property laws and treaties.
The Software is licensed, not sold.

1. Definitions.
a. Software. AGS Publishing Software, and any part thereof.
b. Printed Materials. Any and all printed material that 

accompanies the Software.
c. Single Computer. The one computer, personal data assistant 

(PDA), or any other electronic device on which Licensee is 
permitted to install and/or use the Software.

d. Networked Computer. Any one computer, personal data 
assistant (PDA), or any other electronic device on which 
Licensee is permitted to install and/or use the Software that has 
access to files or applications residing on one or more 
connected computers.

2. License.
a. If Licensee purchases Single Computer, Licensee agrees to install 

only a single copy of the Software on one computer 
(the “Single Computer”).

b. If Licensee purchases Network Software, Licensee may only 
install and use the Software on any Networked Computer or 
single computer physically located on Licensee’s campus.

3. Limitations and Restrictions.
a. Licensee agrees not to make the Software available for use 

through the Internet.
b. Licensee agrees not to redistribute the Software.
c. Licensee agrees not to reverse engineer, decompile, or disassemble

the Software, except and only to the extent that such activity is 
expressly permitted by applicable law notwithstanding 
this limitation.
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d. Licensee agrees not to rent, lease or lend the Software.
e. Licensee agrees not to create derivative works based upon the 

Software, including extraction, in whole or in part, of any images.
f. Licensee agrees not to use the Software to load any unauthorized 

copyrighted third-party materials onto any Single Computer or 
Networked Computer.

4. Confidentiality. Licensee acknowledges and agrees that the Software is 
the confidential and proprietary information and trade secret of
Licensor, and Licensee hereby covenants and agrees to exert its due 
diligence to prevent disclosure or copying of the Software and maintain
the same as confidential. Licensee further covenants and agrees to 
recover, stop, and/or strictly limit any unauthorized disclosure relating 
to the Software which may occur.

5. WARRANTIES. THE SOFTWARE IS PROVIDED “AS IS” WITHOUT 
WARRANTIES OF ANY KIND, WHETHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, ALL IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS, AND WITHOUT ANY 
WARRANTIES AS TO NONINFRINGEMENT OF ANY KIND.

6. WAIVER. LICENSEE AGREES THAT IN NO EVENT SHALL 
LICENSOR BE LIABLE FOR ANY DIRECT, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES WHATSOEVER RESULTING FROM 
LOSS OF USE OF DATA, PROFITS OR BUSINESS INTERRUPTION,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR 
OTHER TORTIOUS CONDUCT, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THE 
SOFTWARE OR ANY PART THEREOF.

7. Indemnification. Licensee agrees to indemnify and hold harmless 
Licensor, its suppliers, subsidiaries, parent companies, officers, and 
employees for any damages, including attorneys’ fees, asserted by any 
third party for any use of the Software.

8. Remedies. Licensee acknowledges that Licensor’s remedies at law for a 
breach or threatened breach of the provisions of this document are 
inadequate and hereby agrees that Licensor shall be entitled to equitable
relief (including, without limitation, injunctive relief) for any breach or 
threatened breach of the terms of this document in addition to any 
other remedies at law or in equity available to Licensor. The terms of
this document shall survive the termination of this License.

9. Termination.
a. Without prejudice to any other rights, Licensor may terminate 

this License if Licensee fails to comply with the terms and 
conditions of this License.

b. In the event of termination, Licensee agrees to destroy all copies 
of the Software and all of its component parts and all 
Printed Materials.
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10. Copyright. Licensee acknowledges and agrees that all copyrights in 
the Software, including but not limited to any images, photographs,
animations, video, audio, music, text and “applets,” incorporated into 
the Software, the accompanying printed materials (“Printed 
Materials”), and any copies of the Software, are owned by Licensor.

11. Reservation. All rights not expressly granted under this License are 
reserved by Licensor.

12. Reasonable Efforts. Licensee agrees to undertake reasonable efforts 
to communicate and enforce all of the terms of this License to 
employees of Licensee who have access to the Software.

13. Notification. Licensee agrees to notify Licensor in writing of any 
unauthorized use within thirty days of becoming aware of said 
unauthorized use.

14. No Waiver of Rights. Licensee agrees that no delay or failure to take 
action represents a waiver of the Licensor’s rights.

15. Governing Law. Licensee agrees that this License is governed by the 
laws of the State of Minnesota, United States of America, and agrees 
to be subject to personal jurisdiction in the state and federal courts of
the State of Minnesota.

16. Export Regulations. Licensee agrees not to import, export, reexport 
the Software in violation of U.S. export laws and regulations.

17. No Joint Venture. Licensee agrees that no joint venture, partnership,
employment, or agency relationship exists between Licensee and 
Licensor as a result of this License or the use of the Software.

18. Severability. If any part of this License is determined to be invalid or 
unenforceable pursuant to applicable law, it shall not affect the 
validity of the entire License. Additionally, such invalid provision shall
be deemed superseded by a valid, enforceable provision and the 
remainder of the License shall continue in effect.

19. Integration. This License represents the entire agreement between 
Licensee and Licensor and supersedes any and all prior or 
contemporaneous communications between the Licensee 
and Licensor.

AGS Publishing is a trademark and trade name of
American Guidance Service, Inc.
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Introduction
The Kaufman Test of Educational Achievement, Second Edition (KTEA-II) is
an individually administered measure of academic achievement for ages 4
1/2 through 25. The test is available in two versions: the Brief Form, which
assesses the achievement domains of reading, math, and written expression;
and the Comprehensive Form, which covers a wider range of achievement
domains and provides in addition an analysis of students’ errors. This 
software provides scoring for the Comprehensive Form.

For more information about the use and interpretation of the KTEA-II,
refer to the KTEA-II Manual.

KTEA-II ASSIST

The KTEA-II ASSIST software can be used on a Windows® or Macintosh®
platform and allows users to complete the following tasks:

◆ Add, edit, and delete ASSIST users

◆ Add, edit, and delete student information

◆ Add, edit, and delete raw scores

◆ Preview, print, and save reports for one or more student

◆ Import or export a list of student information 

◆ Export students’ test records to a research file 

◆ Backup and restore your database

◆ Import or export records to other copies of the KTEA-II ASSIST
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Getting Started
Check that your personal computer meets the computer requirements
below for the KTEA-II ASSIST. Then follow the installation instructions.

Minimum Requirements

Recommended Configuration

Note: Faster configurations provide faster installation and enhance 
software performance.

Installing KTEA-II ASSIST

1. Close all applications.

2. Turn off virus protection for the duration of the install.

3. Insert the KTEA-II ASSIST CD-ROM into the CD-ROM drive.

4. Wait for the auto-launch to appear and go to step 5.

–OR– 

Windows Users:

a. Double-click on My Computer.

b. Double-click on your CD-ROM drive.

c. Double-click on the Setup.exe icon to begin installing.

Macintosh Users:

a. Double-click on the CD icon that appears on your desktop.

b. Double-click on the Setup icon.

5. Follow the step-by-step instructions onscreen to install the
KTEA-II ASSIST.

5

Platform Operating Processor RAM Available hard Monitor 
System drive space Settings

Windows 98, Me, 2000, Pentium II, 128 100 MB with Java 24-bit
XP, or later 300 MHz MB virtual machine;

Macintosh OSX Power Mac 128 60 MB without 
G3 MB Java virtual 

machine

Platform Operating Processor RAM Available hard Monitor 
System drive space Settings

Windows 2000, XP, or Pentium II, 128 100 MB with Java 24-bit
later 400 MHz MB virtual machine;

Macintosh OSX Power Mac 128 60 MB without 
G3 MB Java virtual 

machine
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Opening KTEA-II ASSIST

Use one of the following methods to open the KTEA-II ASSIST:

Double-click on the KTEA-II ASSIST icon located where you chose to
install it.

–OR–

Windows Users: Go to your computer’s Start Menu. Select Programs ➔
AGS ➔ KTEA-II ASSIST ➔ KTEA-II ASSIST.

Macintosh Users: Go to Macintosh HD ➔ Applications ➔ KTEA-II
ASSIST ➔ KTEA-II ASSIST

When launching the KTEA-II ASSIST, type in the following username 
and password:

Username: AGS
Password: safety

Updating KTEA-II ASSIST

Periodically, AGS Publishing may make updates to this product. To 
automatically download these updates, open the Help menu and select
"Check for Updates." Follow the onscreen instructions to complete 
your update.

Note: Your computer must be connected to the Internet to complete 
the download.

Uninstalling KTEA-II ASSIST

Complete the following steps to uninstall the KTEA-II ASSIST:

Windows Users:

1. Click on your computer’s Start button.

2. Select Programs ➔ AGS ➔ KTEA-II ASSIST ➔ Uninstall 
KTEA-II ASSIST. The Uninstall Wizard appears.

3. Follow the onscreen instructions to finish uninstalling.

Macintosh Users:

1. Drag the KTEA-II ASSIST folder and desktop icon to the trash.

2. Empty your trash.
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Getting Around
The KTEA-II ASSIST Software can be used on Windows or Macintosh
operating systems. Resources for using the Windows operating system 
are available on the Worldwide Web at www.microsoft.com. Resources 
for using Macintosh are available at www.apple.com. Bookstores have
additional resources for using both operating systems

Basic Navigation

Use any of these methods to move through the program:

◆ The mouse

◆ The Tab, Enter, Home, End, or arrow keys (                 ) 
on your keyboard

◆ Tap the Space Bar to select buttons, radio buttons, or 
check boxes.



Program Overview
Add New Student(s) and/or Test Record(s)  

Do any of the following:

◆ Enter student information

◆ Enter test information to create a test record

◆ Enter KTEA-II scores

◆ After entering a student’s scores, create a report for that student

See detailed instructions on adding students and test records 

Open an Existing Student’s Information and/or Test Record 

Do any of the following:

◆ View a list of students who have been entered into the program

◆ Open an existing student’s record

◆ Choose to add new student information

◆ Delete a student’s record from the database

See detailed instructions on opening student and test records

Run Reports for Existing Test Records 

Have the computer generate reports for one or more students whose
KTEA-II scores have already been entered.

See detailed instructions on running reports for existing text records 

Import or Export Student Information 

Import a file that contains a list of student information (name, birth date,
and sex, plus other optional items).

Export a list of student information and scores to a research file in a 
tab-delimited text file that can be viewed and edited by many word-
processing, spreadsheet, or database programs, such as Microsoft® Word,
Microsoft® Excel or Microsoft® Access.

See detailed instructions on importing and exporting student data 

8
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Select Your Record Creation Preferences 

Do either of the following:

◆ Set or change your password and choose whether or not to
require a password.

◆ Choose to make test records you enter Private (only you can 
see them; requires password protection) or Public (all users 
can see the records). You can override this feature for individual
test records.

See detailed instructions on setting your password and privacy preferences

Get Help

To access the electronic help file in PDF format, select the Help button
at the top of the ASSIST application window, within the toolbar.

Exit the ASSIST

To exit the KTEA-II ASSIST, select the Exit button          in the toolbar,
or select the File menu and choose “Exit.”



Adding and Editing Users
Note: Only administrators or single users can add or edit users 
in the ASSIST.

To ADD a User:

1. Under the File menu, select Edit Users. The Add/Edit Users
window will appear (see Figure 1, below).

10

Figure 1: Add/Edit Users window

2. Enter a User Name (default is AGS).

3. Enter a Password (default is safety; users can change their 
passwords at any time).

4. Select the User Type (Basic or Admin). The table below outlines
the capabilities of each:

5. Click the Save button.

Basic User Administrative User

Cannot Delete students Can Delete students

Cannot Add, Edit, or Can Add, Edit, or 
Delete other users Delete other users

Cannot view other user’s Can view any test record in the 
PRIVATE test records ASSIST, regardless of privacy 

settings

Cannot delete other users’ Can delete other users’
test records test records
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To EDIT a User:

1. Under the File menu, select Edit Users.

2. Click on the user listing that you want to edit in the table.

3. Edit the information below.

4. Click the Save button when finished.

To DELETE a User:

1. Under the File menu, select Edit Users.

2. Click on the user listing that you want to delete in the table.

3. Click the Delete button.

4. You will be notified if the user you delete owns any test records.
In the pull-down menu, choose another user to take ownership
of these records.

5. Click the OK button. The selected user will now be able to view,
edit, and report on any private records that were owned by the
deleted user.
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Figure 2: Setting Password and Privacy Preferences

Setting Password 
and Privacy Preferences
If you set a password and choose to require it for entry into the program,
you will be prompted for it each time you open the program. You may
want to set default privacy preferences for your records before you begin
entering students. You can change your default preferences at any time.

To Set a Password:

1. Click the Preferences button           in the toolbar.

2. Enter a password in the field (see Figure 2, below).
Note: If no value is entered in the password field, a password 
will not be required.

3. If you want to enter a password each time you open the KTEA-II
ASSIST, select “Always Require a Password.” If not, select “Never
Require a Password.”

4. Click the Save button.

To Set Test Record Privacy Preferences:

Choose one of these options as your default (see Figure 2, below):

Make all my records available to any ASSIST user: Select this option to
allow all ASSIST users to view the test records that you have entered. Note
that you can change the privacy of an individual record at any time,
regardless of the default setting you choose here.

Make all my records private: Select this option to make all of your test
records private. Note that an administrator will reassign the records to
another user if your username is deleted from the program.

Note: Administrative-level ASSIST Users always have access to 
all data entered into the ASSIST.
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Adding New Student(s) 
and/or Test Record(s) 
The first step when using the KTEA-II ASSIST software is entering student
information into the program. To manually enter student information,
follow the instructions below. Note: To enter student information by
importing a list from your data management system, follow the 
instructions in the Importing and Exporting Student Information section.

To ADD new student information to the database:

1. Select the Add New Student(s) and/or Test Records button   
in the toolbar.

2. Fill in the following fields on the Student Information screen 
(see Figure 3, below):

◆ Last Name (required)

◆ First Name (required)

◆ Middle Initial

◆ Birth Date (required)

◆ Sex (required)

◆ ID number

Figure 3: Adding Student Information
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3. Click Save. You will be notified that the record has been saved, and
the Test Records table will appear below (see Figure 4, below).

Figure 4: Student Information with Test Records
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To ADD a new test record:

Once you have entered test scores for this student, the record will be 
listed in the Test Records table (as shown in Figure 4). Adding a test record
requires two steps: entering Test Information and entering Test Scores.

To enter Test Information:

1. Click the Add Test Record button next to the Test Records table.
You will now see the Test Record Information screen 
(see Figure 5, below).

Figure 5: Test Record Information screen

2. Select the correct Test Date.

3. Select whether the student is CURRENTLY in school or not.
If it is summer and the student is not in school, select “No.”

4. If the student is currently in school, select the current grade. If
the student is not in school, select the highest grade completed.

5. Select the form used (Form A or Form B).

6. Select the norms you want to use: Age, Grade: Fall (Aug.-Jan.),
or Grade: Spring (Feb.-July). If the student is not yet in 
kindergarten (Pre-K or no grades completed) or above 
grade 12, only Age Norms can be used.



16

7. Select the Examiner.

◆ If the examiner is not listed, select Edit Examiners.
A window will appear. To add a new examiner:

a. Click the Add New button.

b. Enter the examiner’s name and titles, if applicable.

c. Click Save.

◆ To delete an examiner from the list, click on the examiner’s
name to highlight it and click the Delete button.

◆ To close the window, click the Close button.

8. Choose whether to make the record Public or Private.

◆ Choosing Public will allow all ASSIST users to see 
the record.

◆ Choosing Private will allow only the signed-in user to 
see the record.

9. Complete any optional fields that you want included on the
report (Test Site, Medication, or Reason for Referral).

To enter Test Scores:

1. Click the Next button when all required fields are completed. The
Test Scores screen will appear (see Figure 6, below).

Figure 6: Test Scores screen
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2. Choose the order in which you want subtests to appear. By
default, the subtests will appear in the order that they appear on
the front of the record form (“Composite Order”). To change the
list to match the order of the subtests within the record form and
in the easels, select “Easel Order.”

3. Enter the raw scores for the subtests you administered.

◆ For some subtests, you may instead choose the Sets you 
administered, and then select the Points that the student
obtained. The raw score and standard score will automatically 
be calculated.

◆ For Phonological Awareness, Associational Fluency, and
Naming Facility (RAN), indicate which sections or task pairs
you administered before entering the raw score.

4. Click the Save button when you have finished entering 
your scores.

To create a report for this student:

(Note: To create reports for one or more tests that have already been
entered, click on the Multiple Reports button          in the toolbar and 
follow the directions in the next section.)

To create a report on the test record you just entered:

1. Click the Report button on the bottom of the screen. The Create
Report screen will appear (see Figure 7, below).

Figure 7: Create Report screen
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2. Select the Confidence Level (85%, 90% or 95%).

3. Click to place a checkmark beside the report components you
would like to include in your report. Click again to uncheck the
boxes. You can include the following information in your reports:

◆ Demographics and Test Information: A cover sheet for your
report, providing basic information about the KTEA-II and
any information you've entered about the student

◆ Score Summary Table: Table includes raw and derived scores
(standard scores, confidence intervals, percentile ranks,
descriptive categories, grade or age equivalents, and other
optional scores) for composites and subtests.

◆ Graphical Profile of Scores: Graph presents derived scores and
confidence intervals for composites and subtests, and includes
a normal curve.

◆ Ability-Achievement Discrepancy Analysis: (Only available if
age norms were used). Click in the box next to this option to
enter the student’s score for an ability test. First select the
KABC-II, WJ-III COG, SB5, WISC-IV, DAS, or WAIS-III. Then
select the score type and enter the score. The table on the
report includes the predicted KTEA-II score, the actual score,
and the significance and frequency of occurrence of the 
difference between the actual and predicted scores.

4. If you anticipate using the same report components every time
you create a report, click the Save my Selections button, and your
components will automatically be selected the next time you
come to this screen. You can override your selections for a single
report, but your default component selections will not change
unless you click Save my Selections again.

5. Click the Preview button to view your report.

In the Preview window, you can now Print or Save your file as a PDF:

◆ To Print the report, click the Print button.

◆ To Save the report to your computer in PDF format:

a. Click the Save button.

b. In the pop-up window, choose where you want to 
save your file.

c. Click Save.

Note: You will need Adobe Acrobat Reader to view your saved
file, available free from www.adobe.com.

www.adobe.com
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2. Click once on the student in the list, and then click the Open
Student button in the bottom right
–OR–
Double-click on the student in the list.

3. Edit the necessary fields on the Student Information screen.
4. Click Save

Note: If the student you want to work with is not listed on this screen,
click the Add Student button in the bottom right to add a new student to
the database. Follow the instructions in the Add New Student(s) and Test
Record(s) section.

Figure 8: Select or Add Student screen

Opening an Existing Student’s
Information and/or Test Record
To EDIT previously entered student information:

1. Select the Open Existing Student Information and/or Test Record
button in the toolbar. You will see the Select or Add Student 
screen (see Figure 8, below).
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To DELETE previously entered student information:

Note: Only administrators may delete students. Use caution when 
deleting. We recommend that you backup your database before deleting
any students. (Select File > Backup/Restore. Click Backup. Select a listed
backup and click Restore to return the database to a previous state).

1. Select the Open Existing Student Information and/or Test Record
button in the toolbar.

2. Select the student or students you want to delete.

◆ To select one student, click once on the record entry in the list.

◆ To select multiple students, hold down the Control key
(Windows) or Command key (Macintosh) on your keyboard
and click once on each record entry to highlight it.

3. Click the Delete Student button.

To EDIT a previously entered test record:

1. Open the student information as described above.

2. In the Test Records table, click once on the test record you want
to edit, and then click the Open Test Record button

–OR–

Double-click on the test you want to edit.

3. If necessary, edit the information on the Test Record 
Information screen.

4. Click the Next button to view or edit the Test Scores.

5. Click the Save button to save the updated Test Record
Information and Test Scores.

To DELETE a previously entered test record:

1. Open the student information as described above.

2. In the Test Records table, click once on the test record entry you
want to delete.

3. Click the Delete Test Record button. You will be asked to confirm
that you want to delete the selected test record.
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Creating One or More Reports for
Previously Entered Test Records
To create one or more reports:

1. Click on the Run Reports for Existing Test Records button 
in the toolbar. The Select Administration screen will 
appear (see Figure 9, below).

Figure 9: Select Administration screen

2. Find the test record or records that you want to run reports on by
scrolling through the list, using the Quick Find option.

◆ To use the Quick Find:

a. Type your search criteria in the blank field (e.g. Smith).

b. Select what you are searching by in the pull-down menu
(e.g. Last Name).

c. Records that match your search criteria will appear in the
list. To view all records again, delete any search criteria
from the Quick Find field.
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3. Select the test record or records to report on.

◆ To select one test record, double click on the record entry 
in the list.

◆ To select multiple records, hold down the Control key
(Windows) or Command key (Macintosh) on your keyboard
and click once on each record entry to highlight it.

◆ To select all the records in the list, click the Select All button.

4. Click the Create Report button on the bottom of the screen. The
Create Report screen will appear (see Figure 10, below).

Figure 10: Create Report screen

5. Select the Confidence Level (85%, 90% or 95%).

6. Click to place a checkmark beside the report components you
would like to include in your report. Click again to uncheck the
boxes. You can include the following information in your reports:

◆ Demographics and Test Information: A cover sheet for your
report, providing basic information about the KTEA-II and
any information you've entered about the student

◆ Summary Table: Table includes raw and derived scores 
(standard scores, confidence intervals, percentile ranks,
descriptive categories, grade or age equivalents, and other
optional scores) for composites and subtests.
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◆ Graphical Profile of Scores: Graph presents derived scores and
confidence intervals for composites and subtests, and includes
a normal curve.

◆ Ability-Achievement Discrepancy Analysis: (Only available if
age norms were used). Click in the box next to this option to
enter the student’s score for an ability test. First select the
KABC-II, WJ-III COG, SB5, WISC-IV, DAS, or WAIS-III.
Then select the score type and enter the score. The table on 
the report includes the predicted KTEA-II score, the actual
score, and the significance and frequency of occurrence of
the difference between the actual and predicted scores.

7. If you anticipate using the same report components every time
you create a report, click the Save my Selections button, and your
components will automatically be selected the next time you
come to this screen. You can override your selections for a single
report, but your default component selections will not change
unless you click Save my Selections again.

8. Click the Preview button to view your report.

In the Preview window, you can now Print or Save your file as a PDF:

◆ To Print the report, click the Print button.

◆ To Save the report to your computer in PDF format:

a. Click the Save button.

b. In the pop-up window, choose where you want to 
save your file.

c. Click Save.

Note: You will need Adobe Acrobat Reader to view your
saved file, available free from www.adobe.com.

www.adobe.com
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Importing and Exporting 
Student Information
If you do not want to manually enter all of your student information, the
KTEA-II ASSIST software allows you to import a list of student information.

To Import Student Information into the KTEA-II ASSIST:

There are two steps to importing a data file from another program:
1) preparing the file and 2) importing the file. Both phases are 
addressed below.

To Prepare Your Import File:

1. Export student data from your source application. If you are
unfamiliar with this process, please see your user’s manual or
local technical support.

2. If possible, save the export file directly in a tab-delimited format.

3. You can either import directly (go to step 7), or you can open the
file in a program like Microsoft Excel, where you can easily add to
or edit the information in your data file (see Figure 11, below).

Keep the following things in mind when working with your file:

◆ The order of the columns in your file is not important; after
you import, the KTEA-II ASSIST software will allow you to
specify what each column of data represents.

◆ The following fields can be used:

Import File Field Requirements (* indicates required fields)

Field Description Length Data Type

*Last Name 20 characters any letters

*First Name 20 characters any letters

Middle Initial 1 character any letters

*Birth Date 10 characters mm/dd/yyyy,
m/d/yy
m-d-yy
yyyy-m-d
yyyy/m/d

*Sex 1 character M or F,
Male or Female

ID number 16 characters any numbers

Note: If your file has columns that the KTEA-II ASSIST does not need,
you do not need to remove this extra information. You will be able to tell
the program to ignore selected columns when you import the file.
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5. Select Save as (on the File menu in Microsoft Excel).

6. Select the option to save as “text-only,” “plain text,” or “ASCII
text.” In Microsoft Excel, choose “Text (Tab delimited).”
(see Figure 12, below)

Figure 11: Import File in Microsoft Excel

7. Type in a file name (e.g. “students.txt”), and save the file in a
location on your hard drive that you can easily find again.

To Import Your File:

1. Click the Import/Export Student Data button          in the toolbar.

2. On the Import or Export Data screen, click the Select File button.

3. A window will pop up that will allow you to browse your hard
drive. Find the text file that you just saved and click to select it.

4. Click the Open button. The location of your file will appear in
the “File Name” field on the Import screen.

5. Click the Continue button. You will see the field information
from the first record in your import file (see Figure 13, below).

Figure 12: Save as Text (Tab delimited)

Figure 13: Import Students and Their Information
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6. Use the pull-down menus to select a label for each field. Do 
not select a label for the fields that you don’t want to use; the
software will ignore them (see Figure 14, below).

Figure 14: Assigning labels to an import file

7. When you are finished labeling the fields, select the student or
students you want to import.

◆ To select one student, double click on the record entry in 
the list.

◆ To select multiple students, hold down the Control key
(Windows) or Command key (Macintosh) on your keyboard
and click once on each record entry to highlight it.

◆ To select all the students in the list, click the Select All button.

8. Click the Import button. You will receive a confirmation telling
how many student records were successfully imported, how
many duplicates were ignored, and how many errors were
encountered.
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To Export Student or Test Information from the 
KTEA-II ASSIST

The KTEA-II ASSIST software allows you to export a list of student 
information for use in other programs. You can also export student 
information and test scores into a spreadsheet program 
(such as Microsoft Excel) for use in research.

To Export Student Information only or Student Information and 
Test Records:

1. Click the Import/Export Student Information button 
in the toolbar.

2. In the Export section of the screen, select what you want to
export by clicking the radio button (see Figure 15, below). If you
choose to export students and test records, select whether you
want to include derived scores.

Figure 15: Export Students and Demographics or Students and Test Records

3. Click the Continue button.

4. Find the students or record(s) you want to export 
(see Figure 16, below).

◆ To use the Quick Find:

a. Type your search criteria in the blank field (e.g. Smith).

b. Select what you are searching by in the pull-down menu
(e.g. Last Name).
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5. Select the record or records that you want to export.

◆ To select multiple students, hold down the Control key
(Windows) or the Command key (Macintosh) on your 
keyboard and click on the records.

◆ To select all the records in the list, click the Select All button.

6. Click the Export button.

7. Select a location to save the file.

8. Click Save.

Figure 16: Select Students to Export
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Figure 17. Select Test Record(s)

Merging Test Records
The merging function allows you to share test records across copies of the
KTEA-II ASSIST. Using this function, you can create a merge file with all
of your test records that you can use in another copy of this program, and
you can import a merge file that you have created on another copy of the
KTEA-II ASSIST.

To create a merge file:

1. Click the Import/Export Student Information button   
in the toolbar.

2. In the “Merge Data” section of the window (on the bottom of the
screen), select the option to “Create a merge file to be used by
another copy of the KTEA-II ASSIST”

3. Click the Continue button. You will be taken to the Select Test
Record(s) screen (see Figure 17, below).

4. Select the test records you want to include in your merge file.

◆ To select multiple students, hold down the Control key
(Windows) or the Command key (Macintosh) on your 
keyboard and click on the records.

◆ To select all the records in the list, click the Select All button.

5. Click the Continue button.
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6. In the window that appears, select a location to save your file.

7. Click Save.

To import a merge file:

1. Click the Import/Export Student Information button 
in the toolbar.

2. In the “Merge Data” section of the window (on the bottom of the
screen), select the option to “Import a merge file from another
copy of the KTEA-II ASSIST.”

3. Click the Continue button.

4. In the window that appears, find the location of your merge file.

5. Select the file and click Open. Your students and records should
now be saved in the program.
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Troubleshooting
Problem: Reports and some screens on Macintosh OSX do not honor type
styles, such as bold and italics.

Description: Microsoft Office installs fonts into the Library/fonts/ folder
in the user's home directory. Once installed, these fonts are used by Java
applications instead of those installed with the system, which may cause
problems. The installed fonts include:

◆ Wingdings

◆ Verdana

◆ Times New Roman

◆ Tahoma

◆ Monotype Sorts

◆ Lucida Handwriting

◆ Copperplate Gothic Light

◆ Copperplate Gothic Bold

◆ Impact

◆ Edwardian Script ITC

◆ Curlz MT

◆ Century Gothic

◆ Arial

◆ Comic Sans MS

◆ Arial Black

Workaround: Remove the fonts installed by Microsoft Office that are
causing problems.
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Technical Support
Technical Support is available for the 
KTEA-II ASSIST:

◆ On the AGS Publishing Web site at www.agsnet.com

◆ From the AGS Publishing toll-free number at 800-328-2560 
from 8:00 a.m. to 4:30 p.m. Central Time

www.agsnet.com
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Appendix A:
List of Report Components
Demographics and Test Information

Score Summary Table

Graphical Profile of Scores

Ability–Achievement Discrepancy Analysis



Demographics and Test Information

Report Components
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Score Summary Table

Report Components
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Graphical Profile of Scores

Report Components
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Ability–Achievement Discrepancy Analysis

Report Components
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